Our current students represent 36 U.S. states, 33 countries and 163 colleges and universities.

FSU College of Law

By the Numbers

4
According to preLaw magazine (2021), Florida State is the nation’s #4 law school for government careers and #17 in the nation for public defender/prosecutor jobs.

8th Best
According to preLaw magazine (2020), ranks Florida State the nation’s #8 best value law school.

1st in Florida
According to a 2018 study of law faculty scholarly impact, our faculty is #1 in Florida and #29 nationally.

No.18
According to ABA data, Florida State is the nation’s 18th best law school in terms of 2019 graduates who passed a bar examination in the primary jurisdiction on their first attempt.

3rd Law School
Florida State is the #3 law school in the nation for best student quality of life, according to Princeton Review (2021).

8th Best Law School
FSU Law is the nation’s 8th best law school in terms of average indebtedness of graduates who incurred law school debt.
DEAN’S MESSAGE

MANY FACTORS SHOULD INFLUENCE YOUR CHOICE TO JOIN A LAW SCHOOL COMMUNITY.

I joined this dynamic Florida State University College of Law family for many reasons that I think will resonate with you—a primary reason being the collegial, welcoming environment. At FSU, you will be part of a collaborative community, where students and professors engage deeply both inside and outside of the classroom. Moreover, our students form life-long bonds as they endeavor to study together, support one another and celebrate each other’s successes.

Most law schools advertise that they provide a rich and rewarding student experience, so how should you discern which schools are truly exceptional? My advice is that you should look at the breadth and depth of alumni connection to the school. Given that money and time are both scarce resources, you will want to know whether alumni disappear after graduation or choose to give back. Florida State alumni have one of the highest giving rates in the country. Because students enjoy their time at FSU and they appreciate the support they receive, they stay connected after graduating. Our 10,000-plus alumni are successful in the worlds of law, business and government, and they are eager to help students. You will have access to alums who visit campus regularly, teach courses and guest lecture, and mentor students who seek to launch their legal careers in Florida and elsewhere. Florida State boasts an alumni mentoring network of more than 1,000 lawyers around the world.

Another strength of Florida State is its location. Tallahassee, the capital of the third largest U.S. state, is home to 500-plus law firms, state and federal courts, numerous state agencies, the Governor’s Office and the Florida Legislature, and most are within a short walk of the law school campus. You will have many unique opportunities to gain classroom knowledge and work experience in areas of the law that interest you while strengthening your credentials for long-term employment. These experiences translate into opportunities around the globe.

You will also have access to the fabulous professionals in our Career Services and Professional Development Office who are dedicated to helping students find desired jobs. They work with professors, administrators, alumni and other mentors to help students best position themselves for the legal careers they wish to pursue. Florida State is consistently rated one of the nation’s best in terms of job placement and everyone here will be committed to helping you launch your career.

As we begin the 2021-22 academic year, FSU Law is continuing with some of the innovations that resulted from COVID-19, such as hosting guest speakers from all over the nation for virtual sessions with students. We also are still working on the issues of social justice and racism. At FSU Law, you will find a community that is committed to the prevention of oppression and injustice, as well as the advancement of diversity, inclusion and equity. Students interested in advocating for social justice and change will find an array of curricular and extra-curricular opportunities at FSU.

“FOR ME, ONE OF THE MAIN DRAWS TO FLORIDA STATE WAS THE COMMUNITY. This is a school that is highly ambitious, yet also extremely collegial. You don’t find that mix often and that makes FSU very special. Everyone here has high aspirations, but we all collaborate to the benefit of others and not just ourselves.”

Dean Erin O’Connor is a noted scholar in several areas, including conflict of laws, arbitration and the law market. She received her J.D. from Georgetown University.

Thank you,

Erin O’Connor
Dean and McKenzie Professor
Tallahassee is the **#1 MIDSIZE CITY** and **#3 OVERALL BEST CITY** in the nation for lawyers to pursue careers, according to a 2019 AdvisorSmith study.

This translates into an abundance of job opportunities for law students.
Florida State University College of Law is located in the heart of downtown Tallahassee—the capital of the nation’s third largest state—across the street from the Florida Supreme Court and one block from the Florida Capitol. FSU Law is also a short walk or drive from all state agencies, The Florida Bar, hundreds of law firms, multiple courts, and hundreds of statewide associations and public interest groups. Few other law schools in the nation can compete in terms of location. The unique legal opportunities that accompany being located in a state capital are invaluable. Experiences that FSU Law students have in Tallahassee and around the globe translate into careers all over the world for our graduates in government, public interest organizations and law firms, both large and small.

Many students are interested in state government and the political process, and our location allows us to offer highly specialized classes taught by high-level officials in state politics and administrative law. These courses include Executive Power, Legislative Power, Separation of Powers, and Florida Legislative Practice: From Bill Drafting to the Governor’s Desk. Many of these classes also feature special guests who are engaged in sophisticated legal practice and policy-related work.

According to *preLaw* magazine, Florida State is the nation’s fourth best law school for government careers and 17th best in the nation for public defender/prosecutor jobs. Because a large percentage of FSU Law students aspire to work in government and public interest positions, we devote ourselves to making a wide variety of clinical opportunities in these areas available to students. Our location also allows students to easily work at the Capitol and participate in the Gubernatorial Fellows and Legislative Intern programs—year after year, FSU Law students comprise a majority of the fellowship and internship seats.

Many of the experiences available exclusively to FSU Law students translate into opportunities to change the world and advocate for legal reform. We know a great number of our students want to pursue careers related to social justice, so we offer courses and clinical opportunities that position them to be agents of change in their legal careers.

“Because of FSU Law’s unique placement in the state capital, I have enjoyed opportunities to work in both a well-respected private law firm and for the state government at the Department of Environmental Protection. Being able to work in both the public and private sectors has given me a well-rounded knowledge of the areas in which I hope to focus my practice.”

Allison Barkett (’20) was an undergraduate at the University of Florida.

Tallahassee offers a wide variety of clerking and internship opportunities in its more than 500 law firms, numerous state and federal courts, and the legislative and executive branches of government.
“THE OFFICE OF STUDENT ADVANCEMENT HAS PROVIDED ME WITH GREAT ADVICE AND COUNTLESS STRESS-RELIEVING EVENTS. Their staff members are some of the friendliest individuals on campus. They helped me quickly prepare my student bar application at the start of the semester and hosted tons of wellness events to help students relax. I’ve had the opportunity to attend yoga and healthy cooking classes, Painting with a Twist, and have tea and scones as an afternoon pick-me-up thanks to this amazing office.”

Alexa Castellano (’21) attended the University of Florida for undergrad.

“THE COLLEGE OF LAW IS SO UNIQUE because of the warm and welcoming environment. The students here reject the competitive nature typically associated with a legal education, and I have received so much support with both my academic life and my personal life. The environment completely removes the intimidation factor from the equation and allows students to focus on adjusting and learning the material.”

Bailey Cunningham (’21) attended the University of South Florida for undergrad.
SPECIALIZED STUDENT SUPPORT

WHEN YOU ENROLL AT FSU LAW, you join a community where the administration places a high priority on providing individualized support to students. In addition to support from alumni and faculty members, students have personalized advising, mentoring and counseling resources through several offices on campus.

Our Career Services and Professional Development Office meets one-on-one with law students to help them launch their careers. The Career Services team will collaborate with you to create individualized job-search strategies, based on your specific goals and aspirations. Students receive counseling on a wide range of topics, including interviewing, drafting cover letters and resumes, and searching for jobs in desired locations and practice areas. Through advising and professional development initiatives, the Career Services team prepares students to be knowledgeable, confident and competitive in the legal market.

Our Academic Programs Office was created in 2017 to provide more personalized guidance to students on course selection, and to offer enhanced legal writing and other academic support. The office also is dedicated to helping students and recent graduates as they prepare for bar exams. FSU Law also has a director of bar support and a full-time bar support professor, whose sole focus is helping students prepare for bar exams and who has a strong record of preparing test-takers for success.

The professionals in our Student Advancement Office are always available to assist students. One of the many ways they support students is through our Raising the Bar Professionalism+ Program, which was launched in 2018 to assist students as they begin to form their professional identities. An exciting component of the program is that all third-year students may elect to have a professionalism mentor assigned to them—one who will help them as they transition from law student to new lawyer. This initiative will provide you with many tools to help you thrive in law practice. The office also hosts a wide variety of wellness events for students.

“FSU LAW'S CAREER SERVICES OFFICE provided me with incredible support throughout my search for a summer associate position, which was translated through resume, cover letter, and interview assistance, specifically for the On-Campus Interview Program. The program ensures that students have the opportunity to interview with numerous firms, right on our campus. It is due to the Career Services team’s devotion to student success that I both obtained and felt confident in beginning my summer associate position at Kelley Kronenberg, a multi-practice law firm with over 10 locations.”

Alejandra Gancedo ('22) attended Florida State University for undergrad and worked at Kelley Kronenberg during the summer after her 2L year.
OUR ALUMNI NETWORK

FLORIDA STATE-EDUCATED LAWYERS CAN BE FOUND IN ALMOST EVERY U.S. STATE AND AROUND THE WORLD.

Our 10,000-plus alumni are extraordinarily supportive of our school and students. One measure of the level of graduate engagement is a law school’s alumni giving rate—ours is among the best schools in the nation. Alumni who are financially supportive tend to also provide support in other ways.

Our alumni provide a vital network to help our students find employment. They are generous with their time and donate countless hours to helping students perfect their job search skills and learn about practicing law. Alumni in private firms, the judiciary, government service and nontraditional legal careers regularly visit campus to talk with students about their specific fields of practice, answer students’ questions and conduct mock interviews. They also host networking meetings with students in their cities. Our alumni also provide students clerking and full-time employment opportunities. In addition to visiting campus to interview students, alumni conduct interviews via video conference.

Our engaged and helpful alumni are the principal reason why Florida State law graduates have success in the legal job market. Several of our distinguished alumni are pictured to the right.

Benjamin L. Crump (’95) is founding partner at Ben Crump Law, with offices in Atlanta, Houston, Jackson, Los Angeles, Memphis, Washington, D.C., and Tallahassee. Because Crump has handled many high-profile cases, he has appeared on numerous national news programs. He often visits with students at the law school and has served on our Board of Visitors. More information about him is available on page 30.
SENATOR MEL R. MARTINEZ ('73)
is a former U.S. Senator from Florida. He currently is chairman of the Southeast and Latin America for JPMorgan Chase & Co. He has visited campus on numerous occasions and has served as president of our Alumni Association.

THE HONORABLE MARY S. SCRIVEN ('87)
is a federal judge for the United States District Court for the Middle District of Florida. She has hired several graduates as law clerks.

BEN ODOM ('04)
is vice president of business and legal affairs at NASCAR. He established an externship and has supervised Florida State law students in the program.

JOHN W. FROST, II ('69)
is the founding partner of Frost Law Firm, P.A. He was the first Florida State law graduate to serve as president of The Florida Bar. He was the featured speaker during our 2013 commencement ceremony and the first donor to name a courtroom.

MARKENZY LAPOINTE ('99)
is a partner at Pillsbury in Miami, where he specializes in commercial and federal criminal litigation and high-risk product liability. He is a past president of our Alumni Association.

ALBERTO DOMINGUEZ ('97)
is customer vice president, Walmart at Kimberly-Clark in Arkansas. He has returned to Tallahassee to meet with Florida State law students and established an externship placement at Walmart for students.

JUSTICE RICKY POLSTON ('87)
was the 55th chief justice of the Florida Supreme Court. He is still a justice and regularly teaches courses at the law school and participates in other law school activities.

LAUREN V. PURDY ('11)
is a shareholder at Gunster in Jacksonville. She visits campus to meet with students, has hosted many networking events in her city for students and alumni, and serves on our alumni board.

THE HONORABLE JESSICA G. COSTELLO ('09)
is a county court judge for Florida’s Thirteenth Judicial Circuit in Tampa. She is very engaged with the College of Law and serves on our alumni board.

SHANNON DEPUY BREAM ('96)
anchors the prime time program FoxNews@Night. She also is a chief legal correspondent for the network. Prior to her career in television, she practiced corporate law in Tampa.

MELANIE GRIFFIN ('06)
practices at Shumaker, Loop & Kendrick, LLP in Tampa. She served as president of The Florida Bar Young Lawyers Division for 2013-14 and regularly returns to campus to meet with students. She mentors many Florida State law students and recent graduates and serves on our Board of Visitors and as a J.D. Advisor for our Career Services Office.

BENJAMIN J. GIBSON ('08)
is a partner at Shutts & Bowen in Tallahassee. He is also a member of the First District Court of Appeal Judicial Nominating Commission and The Florida Bar Young Lawyers Division Board of Governors. He regularly returns to the College of Law to interact with students.
“I HAVE HAD NUMEROUS INTERACTIONS WITH THE ALUMNI NETWORK, FROM meeting the inspiring individuals at my Black Law Students Association induction to the personal connection I made with a mentor through the Association for Criminal Justice mentor program. The Florida State Law alumni network is so vast and every informational meeting I attend is filled with individuals talking about how much they love their jobs and how amazing their experience was here at Florida State Law.

Oliver Thomas (’21) attended the University of Central Florida for undergrad.

“MY INTERACTIONS WITH ALUMNI started before I even arrived in Tallahassee. Once I knew I was attending FSU Law, all of the attorneys I was working with were so kind and excited for me that they introduced me to their friends who graduated from FSU Law. They gave me advice about professors that they had taken just five years prior, and I was welcomed into the family before I had even gone to campus! Before and during the pandemic, we’ve had the opportunity to attend networking events hosted by the law school and its student organizations that featured FSU Law alumni from all over the world. Additionally, the local alumni that I’ve met have been so kind and eager to help me learn, so it’s really a global family you’re joining when you decide to come here.”

Shannon Wong (’22) attended Florida State University for undergrad.
Florida State’s alumni network is truly superb, evidenced by our outstanding job placement, extensive mentoring and alumni contribution rates. Hundreds of alumni visit campus each year to meet with our students. Many additional alumni network via video conference.

Kareem Spratling (’06)
is a partner at Bryant Miller Olive in Tampa, where he focuses in the area of public finance. Spratling serves on the FSU Law alumni board and remains involved in law school activities, most recently serving on a 2020 1L Orientation panel. Spratling is a founding member of the law school’s Black Alumni Network.

Melanie C. Kalmanson (’16)
is an associate at Akerman in Tallahassee, where she is a member of the firm’s appellate practice. She remains engaged with FSU Law and law students, serving as a coach for the Moot Court Team and an advisory board member of the Raising the Bar Professionalism+ Program.

Mark S. Ellis (’84)
is executive director of the International Bar Association. Although he is based in London, he is an active member of our alumni board and a frequent visitor to campus. Ellis regularly teaches FSU Law courses and annually supervises Florida State externs in London.

Joshua E. Doyle (’06)
is executive director of The Florida Bar, one of the largest bars in the country. He is an emeritus member of the FSU Law alumni board.
“ATTENDING LAW SCHOOL JUST BLOCKS AWAY from all three branches of our state’s government presents us with opportunities not afforded to most law students. I externed at the Florida Supreme Court during the spring 2020 semester, which allowed me to work in the highest court in the state after a morning of class because of FSU Law’s proximity. This balance of classroom and real-world teaching is what makes FSU Law so special and why I’m proud to be a Seminole.”

Chad Revis (’21), who was president of the Student Bar Association during his 3L year, now works at the Florida Supreme Court after externing there in 2020.
HANDS-ON LEGAL EXPERIENCE

OUR STUDENTS HAVE MANY opportunities to apply what they learn in the classroom in the real world. Florida State’s clinical programs and location in Tallahassee provide students a plethora of options to gain the legal experience that employers desire. Few other law schools in the nation can compete in terms of location. No other law school in Florida can provide the unique legal opportunities that accompany being located in the state capital.

Our law school is within walking distance of the Capitol building, the Florida Supreme Court, the United States District Court for the Northern District of Florida, many government agencies, and large and small law firms. Students have a wide variety of externships, internships, clerkships, live-client clinics and co-curricular opportunities from which to choose. Our students are not limited to work opportunities in just Tallahassee, though. Many of our more than 100 externship placements are located outside of Tallahassee, throughout Florida and beyond. Students often utilize the law school’s strong alumni network to obtain work experience and career advice.

Whether students gain experience through part-time employment, clinical programs or co-curricular organizations, the many opportunities at the law school and in Tallahassee are a tremendous advantage. During the summer, many students also work in major cities throughout Florida and the nation. The College of Law offers online courses so students can still earn academic credit while working anywhere in the world. Students gain the experience that helps them obtain permanent employment upon graduation and, in many cases, minimize the expansion of debt.

WAYS STUDENTS GET EXPERIENCE:

EXTERNSHIP: placement in an off-campus law office or court in which a student earns academic credit by working under the supervision of a practicing lawyer or judge.

LIVE-CLIENT CLINIC: placement in the law school’s Public Interest Law Center or Business Law Clinic, in which a student earns academic credit by aiding in the representation of live clients under the supervision of a practicing clinical professor.

INTERNSHIP: placement in a law office for which a student does not receive academic credit. Internships can be paid or unpaid and in either the public sector or the private sector. Some internships are also referred to as “clerkships” or “fellowships.”

PRO-BONO WORK: placement under the supervision of a lawyer that is specifically approved as public service and is credited toward a student’s mandatory pro-bono program.


Paolo Annino, Glass Professor of Public Interest Law and Director of the Public Interest Law Center and the Children’s Advocacy Clinic
Ph.D., Legal Philosophy, Fordham University
J.D., Florida State University

Richard M. Benham, Entrepreneur in Residence and Director of the Business Law Clinic
J.D., Florida State University

Lawrence S. Krieger, Clinical Professor and Co-Director of Clinical Externship Programs
J.D., University of Florida

Adria E. Quintela, Clinical Professor and Co-Director of Clinical Externship Programs
J.D., Northwestern University

Daynica Harley, Fellow, Children’s Advocacy Clinic and HELP Project
J.D., Florida State University

Darby Kerrigan Scott, Clinical Professor and Director of the International Human Rights Advocacy Clinic
J.D., Florida State University

Ashley Hamill, Clinical Professor and Director of the Immigration and Farmworker Project
J.D., Florida State University
M.A., Columbia University

Daynica Harley, Fellow, Children’s Advocacy Clinic and HELP Project
J.D., Florida State University
THE LAW SCHOOL OFFERS ONE of the most extensive clinical externship programs in the United States. Students earn academic credit while working under the supervision of practicing attorneys. Our program, which has been referred to as a model for the nation, places students in more than 100 offices throughout Florida and elsewhere—far more placement options than many law schools. While many are in Tallahassee—so students can take classes and work simultaneously—we also have placements in cities including Washington, D.C., Miami, New York City, Atlanta, London and Seattle. We have a special judicial externship program for first-year students and we also have several opportunities for students to work in the legal departments of large corporations.

Many of our externships involve the practice of law, which requires students to be certified by the Florida Supreme Court. This certification is beneficial during and after law school as far as gaining experience and employment in public service.

Typical Externship Placements

APPELLATE PRACTICE
- Florida Attorney General’s Office - Criminal Appeals
- Florida Public Defender’s Office - Criminal Appeals

CIVIL - BUSINESS

BUSINESS REGULATION
- Florida Agency for Health Care Administration
- Florida Attorney General’s Office - Antitrust
- Florida Attorney General’s Office - Consumer Protection (Ft. Lauderdale, Jacksonville, Orlando, Tallahassee, Tampa, West Palm Beach)
- Florida Department of Agriculture and Consumer Services
- Florida Department of Business and Professional Regulation
- Florida Department of Health
- Florida Public Service Commission
- U.S. Securities and Exchange Commission (Atlanta, Miami)

CORPORATE COUNSEL
- AssuredPartners (Lake Mary)
- Blue Cross and Blue Shield of Florida (Jacksonville)
- ERI Global (Miami)
- First American Title (Jacksonville)
- First Florida Integrity Bank (Naples)
- G4S (Jupiter)
- Green Point Research (Fort Lauderdale)
- Homeowners Choice Insurance (Miami, Tampa)
- JM Family Enterprises/Southeast Toyota (Deerfield Beach)
- Jabil Circuit, Inc. (St. Petersburg)
- L3Harris (Melbourne)
- NASCAR (Daytona Beach)
- NextEra Energy/Florida Power & Light Company (Tallahassee/Juno Beach)
- Marriott Vacations Worldwide
- Office Depot (Boca Raton)
- Paul Davis Restoration (Jacksonville)
- SBA Communications Corporation (Boca Raton)
- Trulieve (Tallahassee)
- United Soccer League (Tampa)
- White Cap (Atlanta)
- World Fuel Services (Miami)

COURTS WITH BUSINESS CASES
- Circuit/County Court (Tallahassee, nationwide locations)
- Circuit Court/Complex Business Litigation Court (Miami, Fort Lauderdale, Tampa)
- Florida Division of Administrative Hearings
- Florida First District Court of Appeal
- U.S. Bankruptcy Court (Tallahassee, nationwide locations)
- U.S. District Court (Tallahassee, nationwide locations)

GOVERNMENT CONTRACTING
- Florida Department of Management Services
- Florida Department of Transportation
- Florida Housing Finance Corporation

1LS PARTICIPATED IN JUDICIAL EXTERNSHIPS AROUND THE NATION DURING THE SUMMER OF 2021.
“EXTERNING AT THE INTERNATIONAL BAR ASSOCIATION IN LONDON was one of the greatest opportunities FSU offered me. I was able to better my legal researching and writing abilities while learning about a variety of current international issues, all while living in one of the most dynamic and diverse cities in Europe. The externship broadened my global perspective and provided me with a wonderful group of friends and mentors from all over the world.”

Sophie Luchin ('19), pictured in Trafalgar Square, externed at the International Bar Association in London during the summer of 2018.
Typical Externship Placements (continued)

**TAX**
- Legal Services of North Florida Low-Income Tax Clinic (Tallahassee/Quincy)
- U.S. Department of Justice - Tax Division
- U.S. Internal Revenue Service

**CIVIL - ENVIRONMENTAL/LAND USE**
- Blueprint Intergovernmental Agency
- City of Tallahassee - Environmental and Land Use
- City of Orlando - Environmental and Land Use (Tampa)
- Earthjustice
- Florida Department of Environmental Protection
- Florida Division of Administrative Hearings - Environmental
- Florida Fish and Wildlife Conservation Commission
- Florida Public Service Commission
- Florida Sea Grant (Gainesville)
- NextEra Energy/Florida Power & Light Company (Juno Beach, Tallahassee)
- Southwest Florida Water Management District (Tampa)
- U.S. Department of Justice - Environment and Natural Resources Division, Environmental Enforcement Section (Seattle, Washington, D.C.)
- U.S. Environmental Protection Agency - Office of Regional Counsel (Atlanta, Boston, Chicago, Dallas, Denver, New York City, Philadelphia, San Francisco, Seattle)

**CIVIL - THE FLORIDA BAR**
- The Florida Bar, Legal Division
- The Florida Bar, Division of Ethics and Consumer Protection

**CIVIL - GENERAL GOVERNMENT**
- Florida Attorney General's Office - State Programs
- U.S. Senate (Washington, D.C.)

**CIVIL - HEALTH**
- Florida Agency for Health Care Administration
- Center for Disease Control & Prevention (Atlanta)
- Department of Health

**CIVIL - LABOR/EMPLOYMENT**
- Florida Attorney General's Office - Employment
- Florida Commission on Human Relations
- Florida Department of Corrections - Employment Litigation Section
- Florida Public Employees Relations Commission
- U.S. Department of Justice - Civil Rights Division (Washington, D.C.)
- U.S. Equal Employment Opportunity Commission (Miami, New York)

**CIVIL - LEGAL SERVICES/OTHER PUBLIC INTEREST**
- Americans for Immigrant Justice (Miami)
- Bay Area Legal Services
- Community Legal Services of Mid-Florida - Central Florida
- Disability Rights Florida
- Florida Council Against Sexual Violence (Tampa)
- Florida Department of Children and Families
- Florida Justice Institute (Miami)
- Florida Rural Legal Services (Ft. Myers)
- Florida Rural Legal Services, Migrant Farmworker Clinic (remote)
- Guardian Ad Litem (Orlando, Tallahassee, West Palm Beach)
- Gulf Coast Legal Services (St. Petersburg)
- Jacksonville Area Legal Aid (Jacksonville)
- LatinoJustice (Orlando)
- Legal Aid Society of Palm Beach County (West Palm Beach)
- Legal Aid Society of the Orange County Bar Association (Orlando)
- Legal Services of Broward County (Ft. Lauderdale)
- Legal Services of Greater Miami, Inc. (Miami)
- Legal Services of North Florida - Foreclosure Defense
- Legal Services of North Florida Low-Income Tax Clinic (Tallahassee/Quincy)
- Southern Poverty Law Center (Tallahassee)

**CIVIL - LOCAL GOVERNMENT**
- Bay County Attorney's Office
- Brevard County Attorney's Office
- City of Clearwater Attorney's Office
- City of Fort Lauderdale Attorney's Office
- City of Jacksonville Attorney's Office
- City of Jacksonville Office of the General Counsel Municipal Law Clinic
- City of Miami Attorney's Office
- City of Orlando Attorney's Office
- City of Palm Bay Attorney's Office
- City of Sarasota Attorney's Office
- City of Tallahassee Attorney's Office
- City of Tampa Attorney's Office
- City of West Palm Beach Attorney's Office
- Hillsborough County Attorney's Office
- Lee County Attorney's Office
- Leon County Attorney's Office
- Manatee County Attorney's Office
- Monroe County Attorney's Office
- Osceola County Attorney's Office
- Palm Beach County Attorney's Office
- Pinellas County Attorney's Office
- Sarasota County Attorney's Office

**CRIMINAL**
- Federal Public Defender, Capital Habeas Unit (Tallahassee)
- Florida Criminal Conflict and Civil Regional Counsel
- Florida Public Defender/State Attorney Offices (Throughout Florida)
- Innocence Project of Florida
- U.S. Attorney's Office

**INTERNATIONAL/IMMIGRATION**
- Americans for Immigrant Justice (Miami)
- Florida Rural Legal Services, Migrant Farmworker Clinic (remote)
- Human Rights First (New York City)
- International Bar Association (London)
- International Justice Mission (Chiang Mai)
- U.S. Immigration Court (national locations)

**JUDICIAL CLERK**
- 1L Judicial Externships (nationwide locations)
- Circuit/County Court (nationwide locations)
- Circuit Court/Complex Business Litigation Court (Orlando, Miami, Tampa)
- Florida District Courts of Appeal (Tallahassee, other locations)
- Florida Division of Administrative Hearings
- Florida Public Employees Relations Commission
- Florida Supreme Court
- U.S. Bankruptcy Court (Tallahassee, other locations)
- U.S. District Court (Tallahassee, other locations)
- U.S. Immigration Court (Orlando, Miami, other locations)
"EXTERNING WITH THE DISTRICT ATTORNEY’S OFFICE IN MOBILE, ALABAMA gave me immeasurable hands-on training and experience. I was in court every day, handling my own caseload and arguing on behalf of the state, and more importantly, the victims. I am so grateful to the externship program at FSU Law for the opportunity to apply everything I’ve learned in class to the real world—all before my 3L year!"

Mylena Chin-See (’21) attended Florida A&M University for undergrad.

The law school’s Advocacy Center is invaluable to students preparing for externships and co-curricular advocacy competitions. The building has five courtrooms—four with jury boxes—of different sizes and configurations. It is one of the nation’s finest facilities for trial and appellate advocacy training.
“DURING THE SUMMER OF 2021, I completed a judicial externship for the Honorable Embry Kidd of the Middle District of Florida. During my externship, I researched procedural and substantive issues related to civil rights, international law, fraud and statutory violations. I also drafted reports and recommendations, court orders, and legal memoranda. My favorite part of the externship was discussing ongoing trials and cases with law clerks and judges. Overall, I loved my experience at the federal courthouse and am very thankful to my career services advisor, who told me about the judicial externship program and helped me prep for my onboarding interview.”

Brittany Smith (’23) externed for a federal judge during the summer after her 1L year.

179 STUDENTS EXTERNEED AT 81 PLACEMENTS IN 36 CITIES, INCLUDING ATLANTA, FORT LAUDERDALE, NEW YORK CITY, ORLANDO, TAMPA, WASHINGTON, D.C. AND LONDON DURING THE 2020-21 ACADEMIC YEAR.
"THROUGH EXTERNING AT A FORTUNE 500 COMPANY IN ORLANDO, I gained experience in a variety of areas of the law, including contracts, intellectual property, employment, litigation, tax and corporate securities. I gained insight into what corporate culture is like and I had the opportunity to work with some of the most successful individuals in the legal and construction industries. Not only did I learn a lot, but I also gained valuable work experience and connections that will help me procure employment post-graduation. I am beyond grateful to FSU Law’s Externship Office for giving me the opportunity to work at such a prestigious corporation. FSU Law has provided me with invaluable business connections and coming here was the best thing I ever did for myself and my career."

Sheylla Aceves ('20) externed at HD Supply in Orlando during the summer of 2018 and is now director of operations and general counsel at Tiger Concrete and Screed.
“AS A LEGAL EXTERN TO CONGRESSMAN GREG STEUBE in the U.S. House of Representatives, I worked on a variety of issues addressed by the Judiciary Committee and Oversight and Reform Committee. Specifically, I conducted extensive legal research on the potential implementation of a citizenship question on the 2020 Census. I researched the purpose and mission of the Census, the constitutional requirement to enumerate the population, the enactment of the Census Act, and the statutory authority of the Secretary of the Department of Commerce. I am grateful to have witnessed the legislative, executive and judicial branch coalesce to determine the legal implications of the citizenship question and address the discrepancies.”

Christina Castillo (’21), who attended Florida International University for undergrad, pictured with Congressman Greg Steube in Washington, D.C. during her externship in the summer of 2019.

The FSU Law Research Center offers a wide variety of research courses and workshops, as well as one-on-one sessions, to prepare students to produce sophisticated, cost-effective legal research. Students also have access to several small-group study rooms that are equipped with the latest technology. The Research Center’s Technology for Lawyers course provides students with training and information on technology that is changing the practice of law.
“THE BUSINESS LAW CLINIC was a fantastic experience. Even during a pandemic, when classes and clinics had to be remote, Professor Benham was able to bring in knowledgeable speakers who we could network with. My favorite part of the Business Law Clinic was working with clients and seeing their passion for their new business or start-up/invention. We worked on getting our clients’ businesses registered with the state of Florida, helped guide and answer any business law entity formation questions, and offered general advice to maintain a successful business in Florida.”

Kirsten Nowack (’21), who attended Florida State for undergrad, is working at a Palm Beach-based securities law firm.

THE BUSINESS LAW CLINIC: “IN-HOUSE” TRANSACTIONAL LAWYERING

The clinic is part of the College of Law’s comprehensive program in business law, which includes a curriculum with broad offerings in business law, tax, law and economics, and finance, as well as the Business Law Certificate and business externship programs.

Students in the Business Law Clinic learn transactional skills and earn academic credit by helping advise business and social entrepreneurs within the Florida State University community. The clinic teaches students basic bargaining, drafting, risk-assessment, and legal ethics skills necessary to be an effective and creative transactional lawyer. Students conduct a broad range of legal services and participate in other forms of experiential learning, such as role playing, simulations, and the keeping of transactional journals. Students help with client intake, identifying legal and business issues, and developing bargaining strategies. They also assist in choosing the appropriate type of entity and drafting organizational documents, shareholder contracts and licensing agreements. The clinic is part of the College of Law’s comprehensive program in business law, which includes a curriculum with broad offerings in business law, tax, law and economics, and finance, as well as the Business Law Certificate and business externship programs. Florida State students are able to combine traditional classroom learning with hands-on, real-world experience.
“I CAME TO FSU LAW knowing I wanted to pursue a career in public interest, and my clinic experiences through the Public Interest Law Center far exceeded my expectations. The clinics serve an important role in our community, providing representation and legal advice in the service of vulnerable and indigent clients. Through direct representation and legislative advocacy, I had the opportunity to apply the practical skills and trainings I received in the classroom. I am grateful that I get to further pursue my passion for working in children’s advocacy through a graduate fellowship working with Professor Annino.”

Daynica Harley (’21) participated in the Gender and Family Justice Clinic, Children’s Advocacy Clinic, and Human Trafficking and Exploitation Law Project while a student.

THE PUBLIC INTEREST LAW CENTER

FOUNDED IN 1991, the Public Interest Law Center trains second- and third-year law students in legal advocacy, with an emphasis on mentoring, small group discussions and role playing. Students are certified by the Florida Supreme Court to practice under the supervision of attorneys. They interview clients, conduct discovery, draft pleadings and represent clients in a variety of legal forums. Students also advocate before the Florida Legislature and other governmental entities.

Through its live-client clinics and projects—the Children’s Advocacy Clinic, Children in Prison Project, Health Care Access Project, Human Trafficking and Exploitation Law Project, Immigration and Farmworker Project, International Human Rights Advocacy Clinic, and Juvenile Solitary Confinement Project—the Public Interest Law Center provides students with practical skills training and management skills that they will continue to use as practicing attorneys. Students also gain a sense of professional responsibility and invaluable work experience.

Florida State’s program is unique among law school clinical programs because of the wide variety of legal services provided. While other law school clinics specialize in one or two types of cases, the Public Interest Law Center handles everything from family law cases to juvenile delinquency cases to immigration advocacy.

The Center’s work on children in prison has been cited by the United States Supreme Court and featured by national and international media outlets. The Center also has won numerous awards for its work.
ADVOCACY TEAMS

FSU College of Law students obtain legal writing and advocacy experience through several advocacy teams. The law school’s Moot Court Team is ranked the nation’s 8th best and the Trial Team is ranked the nation’s 15th best. The Moot Court Team is also ranked 1st in the nation for national championships won in 2020-2021. FSU Law students also participate in the Vis Moot Court Team, which competes in an international arbitration competition, and mock trial and moot court competitions through the Black Law Students Association. Students participating in FSU Law’s advocacy teams typically travel around the nation and also to Vienna for competitions.

The FSU Law Moot Court Team won a record five national competitions during the 2020-2021 competition season. No other law school in the nation had as many first-place victories and this was the greatest number of national championships won by FSU in one year. Additionally, the Trial Team won first place in the 2020 Buffalo-Niagara Mock Trial Competition.

1. Corinne Bowden (top row, second from right) and Kaitlin Anouge (top row, far right) won the 2021 National Moot Court Competition in Child Welfare & Adoption Law.
2. (L-R) Erin Tuck and Holly Parker Curry won first place in the 2020 Appellate Lawyers Association National Moot Court Competition.
3. (L-R) Rachel Duffy and Genevieve Lemley won the national championship in the 2021 UCLA School of Law Cybersecurity Moot Court Competition.
4. (L-R) Chad Revis and Brooke Stewart placed first in the 2021 Charleston School of Law National Moot Court Competition.
5. (L-R) Hannah DuShane and Gabriela De Almeida placed first in the 2021 Seigenthaler-Sutherland Cup National First Amendment Moot Court Competition.
6. (L-R) Halley Lewis, IV, Sidney Carter, Shaina Ruth and Christopher Ramirez won the 2020 Buffalo-Niagara Mock Trial Competition.
COMPREHENSIVE COURSE LIST

First-Year Courses
- Civil Procedure
- Constitutional Law
- Contracts
- Criminal Law
- Legal Writing and Research
- Legislation & Regulation
- Property
- Torts

Second- and Third-Year Courses

ADMINISTRATIVE LAW & GOVERNMENT
- Administrative Law
- Advanced Legal Research in Administrative Law
- Federal Courts
- Florida Alternative Dispute Resolution
- Florida Legislative Practice: From Bill Drafting to the Governor’s Desk
- Gambling and Pari-Mutuel Law
- Space Law
- State & Local Government
- Textualism and Originalism

CIVIL RIGHTS LAW & SOCIAL JUSTICE
- Children in Prison Project
- Children’s Advocacy Clinic
- Civil Rights Law
- Constitutional Law
- Consumer Protection Law
- Disability Law
- Election Law
- Employment Discrimination
- Employment Law
- Global Health & Pharmaceutical Law
- Health Care Access Project
- Human Rights & National Security
- Human Trafficking
- Human Trafficking and Exploitation Law Project
- Immigration and Farmworker Project
- Immigration Law
- International Human Rights Law
- Juvenile Justice: Skills Practice
- Lawyering a Movement
- Political Law
- Regional Human Rights Systems
- Sexuality & the Law
- Sexuality, Gender & Reproduction
- Special Topics in Human Rights
- Universal Human Rights Systems

CONSTITUTIONAL LAW
- Constitutional Law II
- Election Law
- Florida Constitutional Law
- Separation of Powers Seminar
- Sexuality & the Law
- Supreme Court Role-Play

CORPORATE/BUSINESS LAW
- Advanced (Topics in) Corporate Governance Seminar
- Alternative Dispute Resolution
- Antitrust Law
- Business Ethics
- Business Law & Legislation
- Business Law Clinic
- Business Planning
- Closely Held Business Organizations
- Commercial Law
- Commercial Paper
- Consumer Protection Law
- Contract Drafting
- Corporate Finance
- Corporate Law and Finance Seminar
- Corporate Tax
- Corporations
- Employment Law
- Energy Law and Policy
- Entertainment Law
- Financial Statements Interpretation
- In-House Counsel
- Insurance Law
- International Aspects of Intellectual Property
- International Business Transactions
- International Sales & Arbitration
- International Trade and Investment Law
- International Trade Transactions
- Introduction to Intellectual Property
- The Law & Business of Investment Management

CRIMINAL LAW
- The American Jury
- Capital Punishment Seminar
- Criminal Justice Reform
- Criminal Litigation Skills
- Criminal Procedure: Adjudication
- Criminal Procedure: Police
- Cybersecurity Law
- The Death Penalty and the Supreme Court
- Evidence
- Executive Clemency in Florida
- Federal Criminal Law
- Florida Criminal Procedure
- Gender Justice
- Human Trafficking
- Introduction to International Criminal Law
- Juvenile Justice: Skills Practice
- Postconviction Remedies
- Prison Law & Policy
- Scientific Evidence
- Sentencing Law Seminar
- White Collar Crime

ENVIRONMENTAL LAW
- Administrative Law
- Advanced Legal Research in Administrative Law
- Climate Change Law
- Policy & Science
- Coastal and Ocean Law
- Condominium and Community Housing Law
- Current Issues in Environmental Law & Policy Seminar
- Energy Law and Policy
- Environmental Crimes Seminar

FAMILY LAW
- Children’s Advocacy Clinic
- Estate Planning
- Family Law
- Florida Family Law
- Gender and Family Justice Clinic
- Gender Justice
- Gratuitous Transfers
- Juvenile Justice: Skills Practice

HEALTH LAW
- COVID-19 and Law
- COVID-19 Veterans Legal Clinic
- Global Health & Pharmaceutical Law
- Health Care Access Project
- Health Law
- Public Health Law

INTELLECTUAL PROPERTY, PRIVACY & CYBERSECURITY
- Copyright Law
- Current Topics in Intellectual Property
- Cybersecurity Law
- Entertainment Law
- International Aspects of Intellectual Property
- Introduction to Intellectual Property
- Media and the Law Seminar
- Privacy
- Technology for Lawyers
- Trademarks
“I REALLY ENJOY MY WORK IN THE AREA OF INSURANCE REGULATORY LAW. I speak around the world on the topic, so co-teaching a class on insurance regulation makes sense. As part of the class, we bring in guest speakers. It is especially gratifying to be able to introduce my students to leaders in their respective fields.”

Fred Karlinsky (’92), a shareholder at Greenberg Traurig, P.A. and member of our Board of Visitors, is one of many alumni who serve as adjunct professors for the law school.
“AS A STUDENT, WORKING AT INTERNATIONAL SPEEDWAY CORPORATION not only taught me how to thrive in a corporate setting, but my work with ISC/NASCAR has also allowed me to network with some of the biggest and brightest contacts in motorsports! FSU’s Business Certificate and corporate externship programs taught me to dive in and learn the ins and outs of the business, while providing me with the tools to flourish. I enjoy what I do every day and I am grateful to the programs at FSU that helped get me here.”

Kelsey Pincket (’17) clerked at International Speedway Corporation as a student through the FSU Law corporate externship program and is now corporate counsel at NASCAR.
WE HAVE ANExtraordinarily Strong Business and Tax Program at Florida State University College of Law. We offer our students an extremely sophisticated program to prepare them to enter the worlds of business and finance at the highest possible levels. We offer a full range of doctrinal business courses and additional courses in financial accounting, law and economics, and game theory for business lawyers. We also offer a Business Law Certificate that allows students to strengthen their degree. Students apply what they learn in the classroom and increase their credentials through numerous business-related externships and our Business Law Clinic.

Core Business and Tax Law Faculty

Frederick M. Abbott, Edward Ball Eminent Scholar Professor of International Law
LL.M., University of California, Berkeley
J.D., Yale University

Shawn J. Bayern, Larry and Joyce Beltz Professor of Torts and Associate Dean for Academic Affairs
Closely Held Business Organizations, Contracts, Torts
J.D., University of California, Berkeley

Richard M. Benham, Entrepreneur in Residence
Business Law Clinic, Contract Drafting, Law & Entrepreneurship
J.D., Florida State University

Elissa Philip Gentry, Assistant Professor
Health Law, Law and Economics
Ph.D., Law and Economics, Vanderbilt University
J.D., Vanderbilt University

Steve R. Johnson, Dunbar Family Professor
Administrative Law, Business Planning, International Taxation, Tax Crimes, Taxation, Taxation of Business Entities
J.D., New York University

Jeffrey H. Kahn, Harry M. Walborsky Professor and Associate Dean for Business Law Programs
Taxation, Taxation of Business Entities, Torts
J.D., University of Michigan

Jay Kesten, Associate Professor
Advanced Corporate Governance, Corporate Finance, Corporate Governance, Corporations
LL.M., Harvard University
LL.B., University of British Columbia
For more information about our Business and Tax Law professors, visit law.fsu.edu/business-law-faculty.
Business Externship Opportunities

BUSINESS REGULATION
› Florida Agency for Health Care Administration
› Florida Attorney General’s Office - Antitrust
› Florida Attorney General’s Office - Consumer Protection ( Ft. Lauderdale, Jacksonville, Orlando, Tallahassee, Tampa, West Palm Beach)
› Florida Department of Agriculture and Consumer Services
› Florida Department of Business and Professional Regulation
› Florida Department of Health
› Florida Public Service Commission
› U.S. Securities and Exchange Commission (Atlanta, Miami)

CORPORATE COUNSEL
› AssuredPartners (Lake Mary)
› Blue Cross and Blue Shield of Florida (Jacksonville)
› ERI Global (Miami)
› First American Title (Jacksonville)
› First Florida Integrity Bank (Naples)
› G4S (Jupiter)
› Green Point Research (Fort Lauderdale)
› Homeowners Choice Insurance (Miami, Tampa)
› JM Family Enterprises/Southeast Toyota (Deerfield Beach)
› Jabil Circuit, Inc. (St. Petersburg)
› L3Harris (Melbourne)
› NASCAR (Daytona Beach)
› NextEra Energy/Florida Power & Light Company (Tallahassee/Juno Beach)
› Marriott Vacations Worldwide
› Office Depot (Boca Raton)
› Paul Davis Restoration (Jacksonville)
› SBA Communications Corporation (Boca Raton)
› Trulieve (Tallahassee)
› United Soccer League (Tampa)
› White Cap (Atlanta)
› World Fuel Services (Miami)

COURTS WITH BUSINESS CASES
› Circuit/County Court (Tallahassee, nationwide locations)
› Circuit Court/Complex Business Litigation Court (Miami, Orlando, Tampa)
› Florida Division of Administrative Hearings
› Florida First District Court of Appeal
› U.S. Bankruptcy Court (Tallahassee, nationwide locations)
› U.S. District Court (Tallahassee, nationwide locations)

GOVERNMENT CONTRACTING
› Florida Department of Management Services
› Florida Department of Transportation
› Florida Housing Finance Corporation

TAX
› Legal Services of North Florida Low-Income Tax Clinic (Tallahassee/Quincy)
› U.S. Department of Justice - Tax Division
› U.S. Internal Revenue Service

Business Activities
› Business Law Society
› Florida State University Business Review
› Intellectual Property Law Society
› Real Estate Law Society

Programs for J.D. Students

The Business Law Certificate Program allows students planning a career in business law and finance to receive specialized training in a set of core areas: publicly traded corporations, closely held business entities, corporate finance, law and economics, and taxation. The program carries additional requirements beyond those for the J.D. degree and signals to potential employers that a graduate has advanced training in these core areas. Additionally, J.D. students who are accepted to the graduate program at Florida State University’s College of Business can pursue a joint graduate pathway in law and business (J.D.-M.B.A.).

LL.M. in Business Law

The LL.M. in Business Law is open to students with a J.D. degree and to foreign lawyers. It is designed to provide advanced business law and finance training to lawyers in areas of growing demand, such as regulatory compliance, in-house counsel, transactional law, complex business litigation and financial regulation. Students are matched with program faculty members who mentor them and help them tailor their course of study, based on students’ interests, educational backgrounds and professional needs. The program is available online or on campus.
BUSINESS FACULTY MEMBERS PREVIOUSLY PRACTICED AT TOP FIRMS IN NEW YORK CITY, CHICAGO AND BOSTON, CLERKED FOR FEDERAL JUDGES, AND WERE HIGH-LEVEL ATTORNEYS FOR THE U.S. GOVERNMENT.

BUSINESS COURSES AND SEMINARS

COMMERCIAL LAW
- Commercial Paper
- Consumer Protection Law
- Sales and Leases
- Secured Transactions

CORPORATE LAW & FINANCE
- Advanced (Topics in) Corporate Governance
- Antitrust Law
- Closely Held Business Organizations
- Corporate Finance
- Corporate Law and Finance Seminar
- Corporations
- Financial Statements Interpretation
- In-House Counsel
- Insurance Law
- Introduction to Business, Finance and Commercial Transactions
- Mergers and Acquisitions
- Securities Regulation

INTERNATIONAL BUSINESS
- Global Health & Pharmaceutical Law
- International Aspects of Intellectual Property
- International Business Transactions
- International Sales & Arbitration
- International Trade and Investment Law
- International Trade Transactions

COMMERCIAL LAW
- Commercial Paper
- Consumer Protection Law
- Sales and Leases
- Secured Transactions

CORPORATE LAW & FINANCE
- Advanced (Topics in) Corporate Governance
- Antitrust Law
- Closely Held Business Organizations
- Corporate Finance
- Corporate Law and Finance Seminar
- Corporations
- Financial Statements Interpretation
- In-House Counsel
- Insurance Law
- Introduction to Business, Finance and Commercial Transactions
- Mergers and Acquisitions
- Securities Regulation

INTERNATIONAL BUSINESS
- Global Health & Pharmaceutical Law
- International Aspects of Intellectual Property
- International Business Transactions
- International Sales & Arbitration
- International Trade and Investment Law
- International Trade Transactions

LAW & ECONOMICS
- Law and Economics

REAL ESTATE
- Florida Real Estate Practice: Beyond the Fundamentals
- Land Use Regulation
- Real Estate Finance
- Real Estate Foundations

TAX LAW
- Corporate Tax
- Estate Planning Seminar
- Tax Drafting
- Tax Policy Workshop
- Taxation
- Taxation of Business Entities

TRANSACTIONAL & SKILLS COURSES
- Alternative Dispute Resolution
- Business Law Clinic
- Business Planning
- Contract Drafting
- Negotiation

OTHER BUSINESS COURSES
- Business Ethics
- Business Law & Legislation
- Employment Law
- Energy Law and Policy
- Introduction to Intellectual Property
- The Law of Business of Investment Management
- Oil and Gas Law
- White Collar Crime
“I felt confident about the way the Business Law Certificate Program structured my course schedules in my second and third years. The courses offered within the program provided learning opportunities that I was genuinely interested in and that I knew would serve me well in the future. Moreover, effective teachers, like Professors Johnson and Kesten, gave extraordinary personal care to ensure that my classmates and I understood the material.”

Raul Alvarez (’20) who attended Florida International University for undergrad, served as president of FSU Law’s Cuban American Bar Association as a 3L and is now an associate at Lydecker Diaz.

“The Business Program at FSU Law allowed me to gain many practical skills and experiences that will be useful in my career as an attorney. The work I was able to do in the Business Law Clinic will be useful in whatever industry or area of law I work in. The business law courses were some of my favorite courses at FSU because they had the perfect mix of theoretical discussions and practical assignments.”

Jada Roulhac (’20), who attended the University of Florida for undergrad, was president of the FSU Black Law Students Association as a 3L and is now a contracts attorney at the Florida Department of Environmental Protection.
Benjamin L. Crump ('95) (pictured at the law school) is one of the nation’s top civil rights attorneys and has represented many high-profile clients, including the families of Ahmaud Arbery, George Floyd and Breonna Taylor. Crump hires FSU Law students and visits campus regularly to engage with students.
THE COLLEGE OF LAW’S FACULTY AND STUDENTS ARE AT THE FOREFRONT in advocating for civil rights in our state and nation. Students advance civil rights and social justice through courses, clinical programs, The Florida Law Schools’ Consortium for Racial Justice, the Center For the Advancement of Human Rights, and events sponsored by the FSU Institute on Civil Rights, the Public Interest Law Center and many student organizations. Internationally recognized FSU Law faculty members are experts on the major civil rights issues of our day, such as mass incarceration, human trafficking, solitary confinement, children in prison, reproductive health, LGBTQ+ rights, gender discrimination, voting rights of previously imprisoned persons, immigration rights, disability rights and the death penalty. FSU Law is a leader in placing students in major civil rights law firms, governmental entities and non-governmental organizations, and many of the school’s graduates are leaders in civil rights and social justice movements.

Core Civil Rights Law and Social Justice Faculty

Frederick M. Abbott, Edward Ball Eminent Scholar Professor of International Law Global Health & Pharmaceutical Law LL.M., University of California at Berkeley J.D., Yale University

Paulo Annino, Glass Professor of Public Interest Law Children in Prison Project, Children’s Advocacy Clinic, Health Care Access Project, H.E.L.P. Ph.D., Legal Philosophy, Fordham University J.D., Florida State University

Courtney Cahill, Donald Hinkle Professor Constitutional Law II, Sexuality and the Law Ph.D., Princeton University J.D., Yale University

Avlana K. Eisenberg, Gary & Sallyn Pajcic Professor Prison Law Reform Seminar J.D., Stanford University

Ashley Hamill, Clinical Professor Immigration and Farmworker Project J.D., Florida State University

Wayne A. Logan, Steven M. Goldstein Professor Capital Punishment Seminar J.D., University of Wisconsin

Michael T. Morley, Associate Professor Election Law J.D., Yale University

Lauren Scholz, McConnaughhay and Rissman Professor Privacy Seminar J.D., Harvard University

Darby Kerrigan Scott, Clinical Professor International Human Rights Advocacy Clinic J.D., Florida State University

Mary Ziegler, Stearns Weaver Miller Professor Constitutional Law II, Employment Law J.D., Harvard University
Other Faculty Teaching Civil Rights Law and Social Justice Courses

Terry Coonan, Executive Director of the Center for the Advancement of Human Rights and Courtesy Professor of Law
Human Trafficking, International Human Rights Law
J.D., University of Cincinnati

Civil Rights Law and Social Justice Courses

› Children in Prison Project
› Children’s Advocacy Clinic
› Civil Rights Law
› Constitutional Law II
› Consumer Protection Law
› Disability Law
› Election Law
› Employment Discrimination
› Employment Law
› Global Health & Pharmaceutical Law
› Health Care Access Project
› Human Rights & National Security
› Human Trafficking
› Human Trafficking and Exploitation Law Project (H.E.L.P.)
› Immigration and Farmworker Project
› Immigration Law
› International Human Rights Law
› Juvenile Justice: Skills Practice
› Lawyering a Movement
› Political Law
› Regional Human Rights Systems
› Sexuality and the Law
› Sexuality, Gender & Reproduction
› Special Topics in Human Rights
› Universal Human Rights Systems

Civil Rights Law and Social Justice Activities

› Advocates for Immigrant and Refugee Rights
› American Civil Liberties Union
› American Constitution Society
› Association for Criminal Justice
› Center for the Advancement of Human Rights
› Florida Justice Association - FSU Section
› The Florida Law School’s Consortium for Racial Justice
› If/When/How
› OUTLaw
› Public Interest Law Students Association
› Trafficking in America Task Force
› Women’s Law Symposium

Public Interest Law Center (PILC)

Students acquire real-world work experience and represent clients through the Public Interest Law Center’s clinics and projects. Under the supervision of attorneys, students advocate to empower marginalized communities, including children, human trafficking survivors, persons with disabilities, veterans, immigrants and farmworkers. The Center strives for justice and equitable outcomes through litigation, law reform, advocacy and community legal education. The Center’s work on children in prison has been cited by the United States Supreme Court and featured by national and international media outlets.

13,338

HOURS OF PRO BONO LEGAL SERVICE COMPLETED BY THE CLASS OF 2021

To learn more about our Civil Rights Law and Social Justice professors, visit law.fsu.edu/civil-rights-faculty.
“THE HUMAN RIGHTS and social justice initiatives I was involved with at FSU Law ultimately led to my decision to pursue an Equal Justice Works Fellowship. These initiatives ranged from working at FSU’s Center for the Advancement of Human Rights, enrolling in three PILC clinics, externing with legal service organizations, working as a T.A. for the International Human Rights course, and leading an immigrant rights focused organization on campus. The mentors I gained from all of these spaces never encouraged me to pursue anything less than my passions and dreams.”

Daniela Donoso (‘20) obtained a prestigious, two-year Equal Justice Works Fellowship for after graduation. She is serving at Legal Services of North Florida, where she is creating a comprehensive immigration advocacy program to serve immigrants who are low income and/or crime victims and establishing immigration protocols, procedures and resources.

“ONE OF THE REASONS I chose to attend FSU Law was the opportunity to strengthen my skills and become a civil rights and social justice advocate. I was drawn to the opportunity to get involved with PILC, specifically the Gender and Family Justice Clinic. The clinic allowed me to provide family law information to women in prison, create a legal empowerment project and work on a client’s case. I also value FSU Law’s student organizations for the multitude of guests they bring to campus for us to learn from—they continuously motivate me to be the best advocate I can be.”

Kelly Kaladeen (‘22) attended the University of Florida for undergrad.
“THE CRIMINAL LAW PROGRAM at Florida State University College of Law is one of the things that drew me to FSU. When I was just an admitted student, I got a phone call from Professor Mark Spottswood, who discussed his scientific evidence class with me and I was immediately intrigued because I have never heard of another university offering such a class. In addition to the criminal law faculty members being fantastic, the opportunities provided through externships, such as my externship during the summer before my 3L year at the Innocence Project, made me fall in love with criminal law all over again.”

Madison Johnson (’21) attended Bucknell University for undergrad.

“THE CRIMINAL LAW PROGRAM at FSU Law offers once-in-a-lifetime opportunities. From experienced professionals to knowledgeable faculty, there is always someone available to help students with questions or career advisement. I personally benefited from the externship program. I received real-world practice through trials, motion hearings and day-to-day courtroom procedures. I was ultimately hired by my externship site for post-graduation employment.”

Maria’h Givens (’19) worked at the Office of the State Attorney, Second Judicial Circuit after externing there as a law student. She is now in private practice in Tallahassee.
CURRICULUM & PROGRAMS OF INTEREST >

CRIMINAL LAW

FLORIDA STATE’S STRONG CRIMINAL LAW PROGRAM offers a wide range of courses to prepare students for a career in the field. Our faculty members are nationally or internationally recognized scholars with deep expertise in the area. Our students can obtain hands-on experience through our Public Interest Law Center and an extensive array of clinical externship opportunities. Students are placed in externships throughout the state, including with state and local public defender and prosecutor offices, the U.S. Attorney’s Office and the Innocence Project of Florida. Students can also assist in the work of the university’s Center for the Advancement of Human Rights, with which the College of Law has a close relationship.

Core Criminal Law Faculty

Paolo Annino, Glass Professor of Public Interest Law
Children’s Advocacy Clinic, Juvenile Solitary Confinement Project
Ph.D., Legal Philosophy, Fordham University
J.D., Florida State University

Avlana K. Eisenberg, Gary & Sallly Pajic Professor
Criminal Law, Criminal Procedure, Prison Law Reform Seminar, Professional Responsibility
J.D., Stanford University

Lawrence S. Krieger, Clinical Professor and Co-Director of Clinical Externship Programs
Criminal Practice Clinic
J.D., University of Florida

Wayne A. Logan, Steven M. Goldstein Professor
Capital Punishment Seminar, Controlled Substances: Law, Policy & Enforcement, Criminal Law, Criminal Procedure: Police
J.D., University of Wisconsin

Mark Spottswood, David and Deborah Fonvielle Professor
Evidence, Scientific Evidence
J.D., Northwestern University

Sarah L. Swan, Assistant Professor
Criminal Law, Family Law, Contemporary Topics in Tort Law
J.S.D., Columbia University
LL.M., Columbia University
J.D., University of British Columbia

For more information about our Criminal Law faculty, visit law.fsu.edu/criminal-law-faculty.
Criminal Law Courses and Seminars

› The American Jury
› Capital Punishment Seminar
› Criminal Justice Reform
› Criminal Litigation Skills
› Criminal Procedure: Adjudication
› Criminal Procedure: Police
› Cybersecurity Law
› The Death Penalty and the Supreme Court
› Evidence
› Executive Clemency in Florida
› Federal Criminal Law
› Florida Criminal Procedure
› Gender Justice
› Human Trafficking
› Introduction to International Criminal Law
› Juvenile Justice: Skills Practice
› Postconviction Remedies
› Prison & Law Policy
› Scientific Evidence
› Sentencing Law Seminar
› White Collar Crime

Criminal Law Externship Opportunities

› Federal Public Defender, Capital Habeas Unit
› Florida Criminal Conflict and Civil Regional Counsel
› Florida Public Defender/State Attorney Offices (Throughout Florida)
› Innocence Project of Florida
› U.S. Attorney’s Office

Criminal Law Activities

› Advocates for Immigrant and Refugee Rights
› American Civil Liberties Union
› Association for Criminal Justice
› Center for the Advancement of Human Rights

Public Interest Law Center

Our award-winning Public Interest Law Center conducts cutting-edge juvenile justice work on children in prison. A study published by the Center and its director, Paolo Annino, was cited numerous times by the U.S. Supreme Court in a 2010 landmark decision prohibiting the imposition of life without parole on a juvenile offender who did not commit homicide. Students working at the Center also provide children full legal representation in criminal cases.
Professor Wayne Logan, pictured with several law students, is one of the law school's nationally recognized criminal law experts. His work has been cited by the United States Supreme Court and he has been quoted in The Wall Street Journal and Newsweek.
FLORIDA STATE IS HOME TO ONE OF THE MOST HIGHLY REGARDED ENVIRONMENTAL LAW PROGRAMS in the country. U.S. News & World Report ranks our program 18th strongest in the nation in its 2021 edition of America’s Best Graduate Schools. Our faculty members are among the most distinguished scholars in the fields of environmental, energy and administrative law. A wide variety of courses and a certificate program provide students a solid foundation in environmental, energy and land use law. Students also can take advantage of offerings in related areas of study at Florida State University, as well as externship opportunities in Florida and Washington, D.C.

Core Environmental Law Faculty

Shi-Ling Hsu, D’Alemberte Professor
Climate Change, Cost-Benefit Analysis in Environmental Law, Environmental Law, Interdisciplinary Perspectives on Climate Change: Science, Policy & Law, Natural Resources Law, Property
Ph.D., Agricultural and Resource Economics, University of California at Davis
J.D., Columbia University

Erin Ryan, Elizabeth C. & Clyde W. Atkinson Professor and Associate Dean for Environmental Programs
Environmental Law, Natural Resources Law, Negotiation, Property
J.D., Harvard University

Mark B. Seidenfeld, Patricia A. Dore Professor of Administrative Law
Administrative Law, Legislation & Regulation
J.D., Stanford University

To learn more about our Environmental Law professors, visit law.fsu.edu/environmental-law-faculty.
“THE ENVIRONMENTAL LAW CERTIFICATE PROGRAM was paramount to my success as a law student by providing me with academic guidance, far-reaching knowledge and unparalleled opportunities outside of the classroom. The network of students, faculty, alumni and scholars brought together by the program provided me with valuable insight and experience in an ever-growing area of law.”

Arielle Vanon (’20), who attended the University of Florida for undergrad, is an associate at Cole, Scott & Kissane in West Palm Beach.

“FSU LAW’S ENVIRONMENTAL LAW PROGRAM PROVIDED ME THE ABILITY TO ENTER THE WORKFORCE WITH AN ANALYTICAL AND DETAILED APPROACH to confidently address legal and policy issues. During my time as a student, support from FSU Law uniquely prepared me by allowing me to gain valuable experience through numerous research and professional opportunities, including positions within the state and federal government, private firms and other non-profit organizations. As I work in Congress on legislative issues and investigations, I know that FSU Law’s environmental law program was key in developing me to be able to immediately contribute and lead significant work on environmental, energy, and infrastructure policy.”

Travis Voyles (’17), an Environmental Law Certificate recipient, is now oversight counsel at the U.S. Senate Committee on Environment and Public Works.
Students in FSU's environmental law program—which is ranked 15th best in the nation—have many opportunities to learn about environmental, energy and land use law both inside and outside of the classroom. As part of our program, we host numerous enrichment events featuring some of the nation's top environmental scholars and attorneys.

### Environmental Courses and Seminars

- Administrative Law
- Advanced Legal Research in Administrative Law
- Climate Change Law Policy & Science
- Coastal and Ocean Law
- Condominium and Community Housing Law
- Current Issues in Environmental Law & Policy Seminar
- Energy Law and Policy
- Environmental Crimes Seminar
- Environmental Law
- Florida Environmental Permitting
- Land Use Regulation
- Natural Resources Law
- Natural Resources Law & Policy Seminar
- Oil and Gas Law
- State & Local Government
- Water Resources Law and Policy

### Environmental Externship Opportunities

- Blueprint Intergovernmental Agency
- City of Tallahassee - Environmental and Land Use
- City of Tampa - Environmental and Land Use (Tampa)
- Earthjustice
- Florida Department of Environmental Protection
- Florida Division of Administrative Hearings - Environmental
- Florida Fish and Wildlife Conservation Commission
- Florida Public Service Commission
- Florida Sea Grant (Gainesville)
- NextEra Energy/Florida Power & Light Company (Juno Beach, Tallahassee)
- Southwest Florida Water Management District (Tampa)
- U.S. Department of Justice - Environment and Natural Resources Division, Environmental Enforcement Section (Seattle, Washington, D.C.)
- U.S. Environmental Protection Agency - Office of Regional Counsel (Atlanta, Boston, Chicago, Dallas, Denver, New York City, Philadelphia, San Francisco, Seattle)

### Environmental Activities

- Environmental Law Society
- Environmental Moot Court Competition
- *Journal of Land Use & Environmental Law*
Students in FSU’s environmental law program—which is ranked 15th best in the nation—have many opportunities to learn about environmental, energy and land use law both inside and outside of the classroom. As part of our program, we host numerous enrichment events featuring some of the nation’s top environmental scholars and attorneys.

Programs for J.D. Students

Upon graduation, students who successfully complete the Environmental Law Certificate Program receive a certificate along with their J.D. degree. The certificate signals to employers and others that a student has achieved special competency in the fields of environmental, energy and land use law. Students may select their courses from an extensive menu of curricular and co-curricular offerings, as well as joint graduate pathway programs with other Florida State University departments.

A joint graduate pathway with the School of Urban and Regional Planning (J.D.-M.S.P.) enhances the law school’s ability to provide comprehensive preparation for a career in environmental and land use law. The school is nationally respected and offers a wide array of fields of emphasis. The joint graduate pathway provides an excellent foundation in both the law and the policy of land use. The College of Law, along with the Department of Earth, Ocean & Atmospheric Sciences, also offers a joint graduate pathway in Oceanography: Law and Aquatic Environmental Science (J.D.-M.S.). The joint graduate pathway provides a competitive advantage to graduates interested in environmental science, law and policy.

LL.M. in Environmental Law and Policy

The College of Law’s LL.M. in Environmental Law and Policy gives J.D. holders the opportunity to enhance their knowledge of environmental, land use, natural resources and energy law. Students are matched with program faculty members who mentor them and help design a curriculum that best suits their interests, educational backgrounds and professional needs.
THE COLLEGE OF LAW is an international institution. During my tenure at Florida State, I studied at Oxford under the tutelage of their professors, traveled to Vienna (twice) to compete with thousands of law students from around the world in an international arbitration moot and discussed job opportunities overseas with our alumni abroad. For me, Tallahassee has truly been the gateway to the rest of the world.

Michael Hoffman (’18), pictured in front of Schönbrunn Palace with Natalia Nincevic (’18) when they were in Vienna for the 2018 Vis International Commercial Arbitration Moot Competition, is an assistant state attorney in the Thirteenth Judicial Circuit.
OUR INTERNATIONAL LAW FACULTY MEMBERS HAVE DEEP EXPERTISE IN A VARIETY OF AREAS, including international intellectual property, international trade law, the global pharmaceutical industry, international human rights, comparative law and Chinese law. Their work has helped shape legal issues all over the world. Our program includes a wide array of specialized courses that reflect the expertise of the faculty, a variety of externship opportunities—both international and domestic in location—and a certificate program for students interested in international law. In addition, Florida State offers three exchange programs and the longest-standing summer law program at Oxford University sponsored by an American law school.

Core International Law Faculty

Frederick M. Abbott,
Edward Ball Eminent Scholar
Professor of International Law
LL.M., University of California at Berkeley
J.D., Yale University

David E. Landau,
Mason Ladd Professor and
Associate Dean for International Programs
Comparative Constitutional Law, Conflict of Laws, International Litigation and Arbitration, Public International Law
Ph.D., Political Science, Harvard University
J.D., Harvard University

Tahirih V. Lee,
Associate Professor
Chinese Law, Comparative Law, International Business Transactions, International Trade Simulation
Ph.D., History, Yale University
J.D., Yale University

Other Faculty Teaching International Law Courses

Terry Coonan, Executive Director of the Center for the Advancement of Human Rights and Courtesy Professor of Law
Asylum and Refugee Law
J.D., University of Cincinnati

More information about our International Law faculty is available at law.fsu.edu/international-law-faculty.
Programs for J.D. Students

Florida State’s Certificate Program in International Law recognizes students for a concentration in the area and carries requirements beyond those for a J.D. A certificate signals to potential employers a graduate’s specialization. J.D. students who are accepted to the graduate program at Florida State University’s College of Social Sciences can pursue a joint graduate pathway in law and international affairs (J.D.-M.S.).

Degree Program for Foreign Lawyers

Foreign law graduates can pursue an LL.M. in American Law for Foreign Lawyers. The LL.M. allows students to gain in-depth knowledge of United States law. In recent years, Florida State has been pleased to host lawyers from countries including Brazil, Cambodia, Cameroon, China, Cuba, France, Haiti, Iran, Italy, Jamaica, Korea, Moldova, Nicaragua, Nigeria, Panama, Paraguay, Peru, Slovakia, South Korea, Taiwan, Turkey and Uzbekistan as candidates for our LL.M. in American Law.

LL.M. students receive personal attention and counseling from a faculty advisor to develop a curriculum to fit their specific needs and goals. They are fully integrated into the College of Law community, taking classes alongside J.D. students. This allows LL.M. students to establish professional relationships with other graduate students from around the world, as well the opportunity to work with FSU’s outstanding faculty and J.D. students.

Under Florida law, students from Latin American and Caribbean countries qualify for the same relatively low tuition rates that Florida residents pay, provided they get a small scholarship. There are a number of scholarships available specifically for this purpose.

International Courses and Seminars

- Admirality Law
- Chinese Law
- Comparative Constitutional Law
- Comparative Family Law
- Comparative Law
- COVID-19 and Law
- Global Health & Pharmaceutical Law
- Human Trafficking
- Immigration Law
- International and Foreign Legal Research
- International Aspects of Intellectual Property
- International Business Transactions
- International Human Rights Law
- International Sales & Arbitration
- International Trade and Investment Law
- International Trade Transactions
- Jessup International Law Moot Court Course
- Public International Law
- Surveillance & Intelligence Law
- War

Study Abroad

Students can participate in a summer study abroad program at the University of Oxford in England and in exchange programs with three universities:

- Erasmus University in Rotterdam, the Netherlands
- Griffith University in Brisbane, Australia
- The University of Groningen in Groningen, the Netherlands

International Law/Immigration Externship Opportunities

- Americans for Immigrant Justice (Miami)
- Florida Rural Legal Services, Migrant Farmworker Clinic (remote)
- Human Rights First (New York City)
- International Bar Association (London)
- International Justice Mission (Chiang Mai)
- U.S. Immigration Court (National locations)

International Activities

- Advocates for Immigrant and Refugee Rights
- Center for the Advancement of Human Rights
- Immigration and Farmworker Project
- International Law Students Association
- Journal of Transnational Law & Policy
- Multicultural Law Students Association
Jim Bacchus ('79) is chair of Greenberg Traurig’s Global Practice Group and former chair of the Appellate Body of the World Trade Organization.

“I’VE HAD THE GREAT HONOR OF SERVING IN THE UNITED STATES CONGRESS, of opening an office for a major law firm in Orlando, and serving on a board that settles some of the world’s most important trade disputes. These opportunities are all the result of the excellent legal education I received at Florida State.”

Jim Bacchus ('79) is chair of Greenberg Traurig’s Global Practice Group and former chair of the Appellate Body of the World Trade Organization.

Katie Mesa ('20), who earned the International Law Certificate and served as president of the Women’s Law Symposium as a 2L, is now an attorney at Legal Services of Greater Miami, Inc.

“THE STRENGTH OF THE INTERNATIONAL LAW CERTIFICATE PROGRAM was one of the main reasons why I was drawn to FSU Law. I have been able to tailor my curriculum to my interest in international law through the Oxford program, the Immigration and Farmworker Project, the Journal of Transnational Law & Policy, and the variety of international courses offered. Whether it be in the area of international human rights or international business, I feel prepared to take on the world with my J.D. from FSU Law.”

Katie Mesa ('20), who earned the International Law Certificate and served as president of the Women’s Law Symposium as a 2L, is now an attorney at Legal Services of Greater Miami, Inc.
**JURIS MASTER PROGRAM**

The Florida State University College of Law Juris Master program is designed for students who want to advance in their chosen field as a non-lawyer and to understand important legal, business and regulatory issues. Students may choose from two options: a fully online program or an on-campus program. For both options, the program is flexible with few required courses—students can tailor their curriculum to their specific professional advancement goals.

Students in the part-time online program gain a strong foundation in regulatory compliance and legal risk management. You will also acquire essential legal skills, such as how to read and interpret statutes, regulations and case law, how to conduct legal research, and how to communicate findings to executives, board members and others within your organization. Based on your specific career needs and goals, you can choose one of five concentrations:

- Cybersecurity, Privacy, and Technology Risk Management
- Employment Law and HR Risk Management
- Financial Regulation and Compliance
- Health Care Regulation
- Legal Risk Management, Contracting, and Compliance

On-campus students can earn the Juris Master degree on either a full-time, one-year schedule or on a part-time basis, with the option to take some courses online. The program’s curriculum includes one course specifically designed for Juris Master students: Introduction to Legal Studies and Research, and requires at least two courses from the J.D. first-year courses. Beyond those requirements, you may select from a wide variety of course offerings and may personalize your curriculum by specializing in one of five key areas:

- Business Law
- Administrative Law and Governmental Relations
- Environmental and Land Use Law
- Criminal Law and Justice
- Employment and Human Resources Law

The Juris Master degree is not an LL.M. degree for lawyers. The degree is designed for those who do not intend to become a licensed, practicing attorney and have not completed a Juris Doctorate program. Credits earned in the J.M. program are not transferable to the J.D. program.

**Key Benefits:**

- **Affordable** – Competitively priced
- **Flexible** – Can be completed fully online and on a part-time basis
- **Impactful** – Lessons learned can be quickly applied at work
- **Sophisticated** – Courses are taught by world-class law professors who teach J.D. courses and prominent industry experts

More information about the online Juris Master program is available at [law.fsu.edu/JMonline](http://law.fsu.edu/JMonline). Additional details about the on-campus program are available at [law.fsu.edu/JMoncampus](http://law.fsu.edu/JMoncampus).

**CONCENTRATIONS FOR ONLINE JURIS MASTER STUDENTS**
“I CHOSE THE JURIS MASTER DEGREE
so I could differentiate myself from others as I entered the job market. One of the things that I liked the most about the J.M. program is its great flexibility. I was able to tailor my studies to focus on employment law, contracts, business law and regulatory compliance. I was also able to choose from a large number of online classes as well as on-campus J.D. classes. The Juris Master has already opened doors for me in sport management, and I know it will be equally helpful if I were to move to any other field in which contracts, legal regulation and risk management play a role.”

Anna Bohmer (J.M. ’20)

“FOR THE LAST 20 YEARS, I’ve been analyzing and negotiating service contracts as part of the legal department of a Texas-based oil and gas services company and currently serve as the director of the global contracts group. The FSU J.M. program has far exceeded my expectations. The professors are world-class, the degree specializations are unique and well-covered, but for me, it was the fully online content (no on-campus requirements) and asynchronous nature of the classes that made all the difference. The daily demands on my time are tremendous. It is clear that the J.M. program administrators work hard to ensure that those of us who are working professionals get value from every precious moment of time we devote to the classwork and lectures. The administrators are accessible, supportive and make you feel they are just as invested in your success as you are.”

Jennifer Roemershauser (J.M. ’20)
OUR COMMUNITY

AS AN FSU LAW STUDENT, YOU WILL HAVE ACCESS TO A WIDE VARIETY OF FLORIDA STATE UNIVERSITY AMENITIES AND PROGRAMS.

FSU is a world-class research university with top programs in areas including political science and business. Being a part of this community allows you the option to participate in one of nine joint graduate pathways offered by the College of Law in collaboration with other FSU colleges and schools.

You will also have access to Florida State’s recreational facility, the Leach Center—a 100,000-plus-square-foot gym featuring an indoor track overlooking a 16-lane indoor swimming pool, extensive cardio, strength and weight-lifting equipment, basketball and racquetball courts, and more. You can also take advantage of FSU’s 73-acre, lake-front property where you can swim, canoe, kayak and picnic with friends. Tickets to all FSU sporting events are free for law students, so you can attend the events of Florida State’s 20 NCAA Division I teams at no cost. FSU students also enjoy on-campus facilities for music and comedy shows, bowling and billiards, video games, and movies. The university is also home to the FSU Flying High Circus, one of only two collegiate circuses in the nation.

FSU law students can utilize the University Counseling Center and Health and Wellness Center. The Counseling Center is a welcoming and confidential place to help you overcome challenges that may interfere with your academic progress and emotional well-being. Students may seek couples, group or individual counseling with no out-of-pocket expense. The on-campus Health Center’s many services include general medical care, women’s health services, nutrition assessments, physical therapy, psychiatry, immunizations and more.

The larger Tallahassee community also offers many opportunities for law students. Tallahassee is a relatively small city, which makes it ideal for studying and also translates into a lower cost of living than in larger areas. Despite its size, Tallahassee offers many more unique restaurants and cultural experiences than most comparable cities. If you love being outdoors, Tallahassee and the surrounding areas have many options for hiking, biking, swimming, boating and canoeing. The closest beach is less than an hour from campus. The city also boasts a wide variety of networking and work opportunities that accompany being located in the capital of the third most populous state in the nation.

Joint Graduate Pathways:

- Oceanography: Aquatic Environmental Science and Law, J.D.-M.S.
- Business and Law, J.D.-M.B.A
- Information and Law, J.D.-M.S.
- Information Technology and Law, J.D.-M.S.
- International Affairs and Law, J.D.-M.S.
- Public Administration and Law, J.D.-M.P.A.
- Social Work and Law, J.D.-M.S.W.
- Sport Management and Law, J.D.-M.S.
- Urban and Regional Planning and Law, J.D.-M.S.P.
“Tallahassee is unique because of its dynamic population. Every year, thousands of college students move to Tallahassee, bringing with them their own experiences, and every year thousands of college students leave and bring their new life skills with them wherever they settle down. When you come to FSU Law you are given every opportunity that comes with having the Florida Capitol right in your backyard. You casually run into attorneys in a diverse range of practice areas and get a front row seat for exciting job opportunities. Tallahassee is an amazing place to grow.”

Kelsey Carlton ('21) attended Florida State University for undergrad.

Florida State is the #3 law school in the nation for best student quality of life, according to Princeton Review (2021).
“JUST BECAUSE THE COLLEGE OF LAW IS ON THE OUTER EDGE OF MAIN CAMPUS does not mean law students are precluded from its activities and resources. All FSU students enjoy free access to health and wellness facilities, libraries, men’s and women’s athletic events, and fine arts performances. Law students can also participate in graduate joint master’s programs offered in conjunction with the Colleges of Business and Social Work, among others. FSU Law is the perfect balance of a small college atmosphere with large university opportunities.”

Sofia Azpurua (’23) attended Florida State University for undergrad.

FSU Law’s Student Bar Association has been honored as the nation’s best four consecutive years and nine times since 2008. Our Black Law Students Association has been named National Chapter of the Year four times since 2011.
Southern Living (2020) ranks Tallahassee the NATION’S 10TH BEST SOUTHERN CITY.
The College of Law seeks to admit and enroll students who, together, bring to the law school a varied set of backgrounds, interests, personal and professional experiences and perspectives, who also have a record of academic success and a competitive LSAT score. Other factors considered include exceptional personal talents, interesting or demanding work or service experience, rigorousness of undergraduate course study, leadership potential, graduate study, maturity and the ability to communicate effectively in writing. An applicant’s responses to the character and fitness questions in the application are also a significant factor in the decision-making process. Although a holistic approach is taken when reviewing applications, most admission decisions are based on the combination of LSAT or GRE score and undergraduate academic performance.

Florida State University encourages applications for admission from qualified students regardless of race, creed, color, sex, religion, national origin, age, disability, veteran or marital status, sexual orientation, gender identity, gender expression, or any other protected group status in accordance with all pertinent federal, state, and local laws on non-discrimination and equal opportunity.

If you have questions about the admissions process or the Florida State University College of Law, please contact the Office of Admissions at 850.644.3787 or admissions@law.fsu.edu.

**Important Dates & Deadlines for First-Time J.D. Applicants**

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 1, 2021</td>
<td>Florida State Law begins accepting applications. Decisions are made on a rolling basis throughout the cycle.</td>
</tr>
<tr>
<td>October 1, 2021</td>
<td>2021-2022 Free Application for Federal Student Aid (FAFSA) applications become available. FSU Law’s school code is 001489.</td>
</tr>
<tr>
<td>December 15, 2021</td>
<td>Deadline to apply as an Early Binding Decision candidate. Please visit our website for specifics regarding applying as an Early Binding Decision candidate.</td>
</tr>
<tr>
<td>January 21, 2022</td>
<td>Early Binding Decision applicants notified of the decision on their application.</td>
</tr>
<tr>
<td>January 31, 2022</td>
<td>Early Binding Decision deposits are due.</td>
</tr>
<tr>
<td>February 28, 2022</td>
<td>Fall 2022 priority application deadline. Priority consideration given to the strongest applications completed by the priority deadline.</td>
</tr>
<tr>
<td>April 15, 2022</td>
<td>Acceptance deadline for admits—decision statement and $200 non-refundable seat deposit due for applicants admitted through March 31, 2021. Deadlines for applicants admitted post March 31 are on a rolling basis.</td>
</tr>
<tr>
<td>July 15, 2022</td>
<td>Fall 2021 application deadline.</td>
</tr>
</tbody>
</table>

**ELIGIBILITY**

An applicant must hold, or expect to receive, a baccalaureate degree from a regionally accredited college or university before beginning the study of law. Individuals who have previously attended law school are not eligible to apply as a first-time entering student.
Application Checklist

For specific details regarding the checklist items, visit Admissions & Financial Aid on our website at law.fsu.edu.

REQUIRED ITEMS
› Register with the Law School Admission Council (LSAC) Credential Assembly Service (CAS)
› Online application through LSAC
› Application fee: $30 paid online through LSAC
› Submit transcripts for all undergraduate and graduate coursework completed through CAS
› Take the Law School Admission Test (LSAT) OR the Graduate Admission Test (GRE)
› **Note regarding GRE scores:** Applicants may submit scores from either the LSAT or GRE as part of their application, but not both test scores. If an applicant has an existing reportable LSAT score, a GRE will not be considered in lieu of the existing LSAT score.
› **Note regarding LSAT Writing portion:** Applicants must take the LSAT Writing portion, which is independently tested, before their LSAT score will be released by LSAC in the CAS report for the application
› Personal Statement
› Resume

OPTIONAL ITEMS
› Academic Addendum
› Diversity Statement
› Letters of Recommendation (2)

J.D. International Applicants
› Submit foreign transcripts for processing through the LSAC JD CAS.
› Submit official TOEFL or IELTS score to LSAC CAS.

The minimum TOEFL score required is a 100 on the internet-based test, 250 on the computer-based test or a 600 on the paper-based test. The LSAC TOEFL code for the JD CAS is 0058. The law school also accepts the International English Language Testing System (IELTS): The minimum score required is a 7.5 on the IELTS. Questions about the JD CAS can be directed to LSAC at 215.968.1001 or lsacinfo@lsac.org.

Transfer Eligibility
Florida State accepts transfer applicants from ABA-approved law schools in the fall, spring and summer semesters. Transfer applicants must be in good standing at their current law school and any previous law schools to be eligible for consideration. Academic dismissal from any law school disqualifies a student from being considered for admission.

Transfer applicants must have earned no more than 43 credits to be eligible. The minimum acceptable LSAT score for transfer is a 147.

Visitor Admission
The College of Law accepts applications from students who have completed their second year of law school at another ABA-accredited institution who would like to be a visiting student at Florida State for one or two semesters of their third year. Students in their second year may be considered on a space-available basis. Preference will be given to students who have a significant professional or personal reason to attend Florida State University College of Law. Detailed application instructions are available at law.fsu.edu.

3+3 Admission
Under 3+3 programs, students who meet certain admission requirements can complete a bachelor’s degree and a law degree in six years rather than the traditional seven, saving a year of time and costs. We currently have programs with Eckerd College, Florida State University, Saint Leo University, the University of Central Florida, the University of North Florida, and the University of West Florida, and expect to add agreements with additional institutions in the future. Details about requirements for each school are available at law.fsu.edu/3-plus-3.

LL.M. Admission
Florida State offers three LL.M. degrees: the LL.M. in Business Law, the LL.M. in Environmental Law and Policy and the LL.M. in American Law for Foreign Lawyers. Detailed application instructions, eligibility information and application deadlines are available at law.fsu.edu/admissions/llm-procedures.

Juris Master Admission
The Florida State University College of Law Juris Master program is flexible and intended for those who possess a bachelor’s degree and who want to advance their careers with legal studies and training. Details about requirements for the program and the application are available at law.fsu.edu/admissions/juris-master.
**J.D. CLASS OF 2024 PROFILE**

158 **STUDENTS**

- 25% have traveled abroad to 30+ countries
- 38% speak at least one language in addition to English

637 **YEARS** combined total years of work experience

- 66% received a scholarship from FSU Law

**ETHNIC/RACIAL DIVERSITY:**

- 39%
  - African American
  - Asian/Pacific Islander
  - Caucasian
  - Hispanic/Latino

**AGE RANGE:**

- 19-61
- Average Age: 23

**First-Generation Law:** 73%

**Previous Graduate or Professional Degree:** 6%

**75th LSAT/GPA:** 164/3.91

- Median LSAT/GPA: 163/3.82
- 25th LSAT/GPA: 158/3.56

*As of August 19, 2021*
Florida State is rated the nation’s eighth best value law school by *preLaw* magazine. Tuition and fees are established by the Florida Board of Governors and the Florida Legislature and are subject to change each year.

## Financial Assistance

The law school offers a program of scholarship assistance made available through the generous support of alumni and friends. Law school scholarships are awarded to students on the basis of merit and/or financial need. Entering first-year J.D. students are considered for scholarships only after being admitted to the College of Law. Second- and third-year students may apply for a variety of scholarships each spring for the upcoming academic year. For information about financial aid in general, contact Ryan Mullins in the FSU Office of Financial Aid at 850.644.1903 or ramullins@fsu.edu.

Most students qualify for federal funding through the Direct Unsubsidized Stafford Loan and Direct Graduate PLUS Loan programs. Eligibility for federal funding is determined by the Free Application for Federal Student Aid (FAFSA). To ensure Florida State University College of Law receives your FAFSA report, you must include our school code (001489) in the application. Students are encouraged to submit the FAFSA as close to the release date as possible for priority consideration. For 2021-2022, the release date is October 1, 2021.

### 2021–2022 Cost of Attendance

For fall and spring semesters

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>FLORIDA RESIDENT</th>
<th>NON-RESIDENT*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuition &amp; Fees (30 credit hours)</td>
<td>$ 20,640</td>
<td>$ 40,650</td>
</tr>
<tr>
<td>Room/Board</td>
<td>13,000</td>
<td>13,000</td>
</tr>
<tr>
<td>Books/Supplies</td>
<td>1,700</td>
<td>1,700</td>
</tr>
<tr>
<td>Transportation</td>
<td>1,500</td>
<td>1,500</td>
</tr>
<tr>
<td>Personal</td>
<td>5,000</td>
<td>5,000</td>
</tr>
<tr>
<td>Includes estimated health insurance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Laptop (for 1Ls)</td>
<td>1,500</td>
<td>1,500</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 41,840</td>
<td>$ 61,850*</td>
</tr>
</tbody>
</table>

* OUT-OF-STATE STUDENTS Most non-residents are eligible to reclassify as Florida residents for tuition purposes after the 1L year. For information about the reclassification process, contact the law school’s Office of Admissions at 850.644.3787 or admissions@law.fsu.edu.

** Online program costs will vary. Visit our website for more information.

** FSU Law is the nation’s 8th best law school in terms of average indebtedness of graduates who incurred law school debt.
College of Law Library

College of Law Rotunda Building

College of Law Main Classroom Building

College of Law Green

College of Law Advocacy Center